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The Complete Guide to Music Technology using Cubase
Sample Chapter

This is a sample of part of a chapter from 'The Complete Guide to Music Technol-
ogy', ISBN 978-0-244-05314-7, available from lulu.com.

It's published by musictechtuition.com, and for more information on the book, 
please go to :

http://musictechtuition.com/books/complete-guide-music-technology/the-com-
plete-guide-to-music-technology-using-cubase-9-5/

The content shown here is around 25% of the first chapter of the book, taking 
the user through basic sequencing and recording, but it covers many more tech-
niques in over 600 pages:

•	 Sequencing - from basics to complex editing
•	 Samplers - Including Sampler Tracks
•	 Synthesizers - theory and programming
•	 Microphones - types, characteristics and placement
•	 Music Theory - understanding why music works
•	 Arrangements - how to arrange a piece in a new style
•	 Audio Editing - detailed editing techniques
•	 Effects - effects types and applications
•	 Mixing - techniques and practice
•	 The Mix Console - mixing effectively with Cubase
•	 Automation - making your mixes more interesting
•	 Chords - chord tracks, editing and chord pads
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Cubase 9.5 is music production software, and one of its features is that it is a se-
quencer.  This means it can record notes that you play on a keyboard, and then 
play them back through a synthesizer, allowing you to create compositions and 
hear what they sound like without using other musicians.  Very complex pieces 
of music can be built up doing this as you can create one track at a time and re-
record it until you are totally happy with it, all at your own pace.  You don’t need 
to be a good keyboard player to get good results, either (although having some 
keyboard skills is a big help).  It’s important to remember that it deals with MIDI 
(which will be covered fully later on), and that really means notes being played, 
usually on a keyboard, so you can change the sound of what you’ve recorded af-
terwards, but there are some limitations to how it will sound.

Getting Started
Firstly you will need to start your computer and any other items in your setup.  
The order of this will change depending on your specific equipment, but there is 
a good rule of thumb here:
Tip: The speakers should be the last thing you turn on, and the first thing that you 
turn off – this is to avoid any ‘thumps’ damaging them (or your ears) when you 
turn the equipment on.  Usually the computer will be one of the first things to be 
turned on and the last to turn off. Once this is done, you can start Cubase. 

 Once it loads (which can take some time as it’s a large 
program), you will see a screen like the one on the left, 
it is the Steinberg Hub and it is there to allow you to 
pick from a number of templates, as well as tell Cubase 
where you want your project to be saved.

Tip: Whenever you use Cubase, it’s important to make sure your files are where 
they should be – in some situations the computer is used by a number of people, 
and in addition it’s really important to save each project in a separate folder – this 
means you will easily be able to back your work up later on.
To create a new folder for your project, click in the area next to Project Folder at 
the bottom right of the Steinberg Hub window, and type the name of the folder 
you want to create, and then in the upper section click More and then pick Empty.  
Now click the Create button at the bottom and Cubase will make the folder and 
a new project. 
Tip: Remember that USB flash drives and external hard drives are becoming in-
creasingly affordable, and their cost is small compared to the amount of time 
that you would need to recreate any work if it was lost.  Backing up your work is 
a necessity, as is regularly saving your work.  Computers crash, particularly when 
running complex software such as sequencers, and hard drives fail.  If you save 
regularly and back up often then you will not lose a great deal if the worst hap-
pens.



4

Sequencing - Sample Chapter

sa
m

pl
e 

do
wnl

oa
de

d 
fro

m
 

www.m
us

ict
ec

ht
ui

tio
n.

co
m

Here we see the main Cubase window, 
with the Transport Bar at the bottom.  The 
transport bar is like the remote control 
for a video recorder, although it has more 
functions, the basic controls are the same, 
as we’ll see later on. The central area is 
the project window.  This is where all your 
tracks will be created and the majority of 
your work will be.

The first thing to do is to create a new track.  Go to Project > Add Track > In-
strument, and a new window will appear where you can select an Instrument.

Click where the window says No VST Instrument and a list will appear of the in-
struments your computer has available.  Pick Prologue from the Synth folder (as it 
is available on all Cubase 9.5 systems), and click Add Track.  You should now see 
a screen similar to the one shown below.

Here there is a track called Prologue 01, 
and to the left of it the Inspector, which 
shows details about it, such as the track 
name, inputs and outputs, etc, as shown 
on the left of this screen shot.  If the in-
spector isn’t enabled, then hit SHIFT + F2 
and tick Right Zone in the box that ap-
pears.

The Inspector is very important as it allows you to alter the volume and panning 
of a track (more of this later), and most importantly pick the sounds you wish to 
use.  We will see how this works in a while, but firstly we will look at a few things 
we need before we get started.
The Transport
The transport (hit F2 if you can’t see it) allows us to control Cubase, making it play, 
stop, record, rewind and a host of other features.  We won’t cover them all here, 
but we will cover the basic controls that you need to get you sequencing.

The transport controls, allowing us to control Cubase 
and move to different parts of the song, much like a 
video or DVD recorder.  In addition, there are controls 
to go to the previous marker or zero (at the left), the 
end of the song (2nd button in), and cycle mode (5th 
button in), which we’ll see later on.
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Tempo control, metronome and count-in.  Here the 
tempo can be set (once the tempo track is turned off 
by clicking the button at the top left), and the click and 
count in can be turned on and off with the bottom two 
buttons.
Time readout.  This can be in a number of formats, 
but bars and beats (at left) is probably the best setting.
Locators.  As we’ll see later on, the locators allow us to 
cycle round a section, to practice it or record several 
times.  They can be set by double-clicking the num-
bers and typing a new value.

Input/Output activity.  This shows MIDI in and out 
(left two meters, red and green) and audio input and 
output; initially only the MIDI meters will be of use to 
you.

Master Fader This control allows you quick access to 
Cubase’s master fader to control the overall volume of 
your sequencing

The Metronome
It is very important that when you play music into Cubase that it is in time with 
the metronome.  Computers may work extremely quickly, but they do not have 
much intelligence, and as a result they need to be told things that we may take 
for granted.  One of them is the tempo of a piece of music – Cubase can’t really 
work that out, so to make life easy in the long run, you should play in time with 
the metronome.  This is easily achieved, firstly by turning it on!  To do that, click 
the button marked click in the transport bar – it will turn light blue, and pressing 
Play on the transport bar should now mean you hear an indication of the tempo 
of the piece. 
Changing Tempo
 If you want to change the speed, make sure that the tempo track is turned off 
(click TEMPO) on the transport bar so that it is dark grey, and then enter the tempo 
that you want by double-clicking it and typing the speed you want.  You may need 
to experiment to find the right speed, and remember that you can always change 
the speed of what you’ve recorded after you’ve done it.  This has an important 
benefit if you’re finding a part difficult - you can record difficult parts slowly to 
make them easier to play, then return the tempo to normal afterwards.
Picking a sound
Many synthesizers provide a wide range of sounds (referred to as patches) and 
these should cover most eventualities – there are usually over a hundred on a 
basic synth, and on some there can be thousands.  However, picking them can be 
a little difficult as there are so many to choose from, but the Inspector makes it 
easier.
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Here is the inspector, with the Prologue in the 
track.  The black area at the bottom (above No 
Drum Map) is where the patch name will appear 
when one is selected, so click there... 

... and the patch list appears.  Here you can list all 
the sounds that the synth has, and there are many 
(334, as shown at the top right).  If you want to 
explore, feel free to do so, you can scroll through 
the list and click once on a sound and you will be 
able to hear it played using your MIDI keyboard 
– you may find a sound that inspires you or takes 
your compositions in new directions. 

There are so many sounds that it’s hard to find 
the right one quickly.  If you click where it says 
Search Results and enter a word (or part of one) 
then it will only show you sounds that are rele-
vant to that – both in their names and also their 
categories/description, so if you enter bass (as 
seen here) then you should get bass sounds, even 
if their name doesn’t make that obvious.  Not all 
instruments have descriptions in their patches, 
however.

Naming your tracks
It’s important to name each track – at first it’s easy to know what’s what as you 
may only have one or two tracks.  When your piece develops, you may end up 
with many tracks, and knowing instantly what each one is will help.  To name 
it, double click where the track says Prologue 01 and name it appropriately – 
melody, bass, chords or whatever you want to call it.  If you have the Info Line 
present (click the icon at the right if it isn’t), then you can name each part as well, 
avoiding confusion if you have musically different parts.  It can also be of benefit 
to use the colour palette  to colour parts, providing an instant visual clue when a 
part is different from its neighbours.

Making a recording
Cubase will record whatever you play on the keyboard.  To do this, select a track 
(if you only have one it will already be selected, this is shown by it being lighter 
than the others), and look to see that the red ‘record enable’ button is lit up on 
the track itself – it should be as soon as you select the track, but it’s possible for 
it to be turned off.  This button doesn’t mean that the track is recording straight 
away, but it means that when you press record it will record on this track.  Next, 
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we need to tell Cubase to give us a count-in (normally this is 2 bars).  This is done 
by activating the Precount/Click button, near Click – it looks like this: - 

Now make sure Cubase is at the start of the song, and hit Record.  Cubase will give 
you a 2 bar count-in, and then start recording.  Play something on the keyboard, 
and you should see it appear as you’re recording.  Once you’re happy, press Stop.  
Go back to the beginning of the piece (use the buttons on the transport bar to do 
this)and press play to hear what you recorded.
If you’re not happy with the recording, then often the best thing to do is to delete 
it and start again – unless there is some unique part of it that you think you could 
never reproduce, the best thing to do is to start again, as this will improve your 
keyboard skills quite quickly if they need to be improved, and mean that in the 
future you can sequence things with much more speed and accuracy.  
Tip: To delete a part, select it (left-click it) and then hit Backspace on the com-
puter keyboard.  
To record again, just repeat the steps above.
Snap
Snap is extremely important.  Without it, it would be very difficult to make parts 
in the project window which were exactly the right length, whether it’s bars or 
beats we are after. What snap does is makes sure that any movements you make 
and any edits you do are constrained to a grid, which minimizes the room for 
errors. Whenever you’re making any changes in the project window, make sure 
that snap is turned on, and initially make sure that it’s set to Bar.  The settings for 
Snap are found at the top of the project window, and the correct ones are shown 
below:

The button at the left turns snap on or off.  Next to it is an area that shows the 
current setting (which is set to Grid).  The size of the grid is set by the next two 
boxes - the first is currently set to Bar (which we want).  Ignore the 1/16 section 
for the time being – this only applies if the middle menu is set to Use Quantize, 
which you will need later on.
Later on, as your sequencing develops, you will find times when you don’t want to 
use snap, or you want it set to different values.  But initially it’s best to stick with 
it set to a grid of bars, as this leaves the least room for problems!
Trimming a part to size
When creating a song, it’s often made up of smaller ‘building blocks’ – these could 
be a verse, chorus or other section of a song that you wish to repeat.  When you 
originally record them, they might end up being too long, for instance if you didn’t 
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hit stop right on the end of a bar, you may well end up with a bar of silence.  This 
can be easily trimmed away – just hover your mouse over the part in question, 
and it will have small  ‘handles’ at the bottom corners – one for the start and one 
for the end.

Here we see the part, with a bar of 
silence at the end.  At the bottom cor-
ners there are ‘handles’ which you 
can click and drag to size the part.

If the part has been selected, it will 
look like this - dark with the ‘handles’ 
being lighter.

In either case, you can click and drag 
the end one to the left...
... to produce a part of the correct 
length.  Note that if you do this to 
an area which has notes in it, they 
will not be played, but they are not 
lost – you can extend the part again 
using this technique and they will re-
appear.

Make sure snap is turned on when doing this, or the timing of your part will suffer.
Adding another track
To add another track, you can do so in the way you did before – go to Project > 
Add Track > Instrument.  It is important to experiment with the different Instru-
ments you have on your system, which can create a wide range of sounds.
Adding Drums
Drums are an important part of many styles of music, so adding them is often 
needed.  To do this, create an instrument track as shown above, but this time you 
will pick Halion One from the Instrument menu.  Now, using the patch selector (as 
shown on page 5) pick the Dry Standard Kit (remember you can search for it 
with the keyword ‘drum’). This means that instead of playing notes, the keyboard 
will play drum sounds – on most keyboards/synths you will find that the C note to 
the left of the keyboard will be a bass drum, with snare above it on D and E, toms 
above that, while the hi-hats will be on F#, G# and A#.  Learning what sounds are 
where will take some time (experiment to find which sounds are where), but the 
basic parts of the drum kit are found on the left-hand end of the keyboard.  There 
is a map of some of the keyboard in the MIDI Chapter on page 51.  As before, 
recording drums is just like recording any other MIDI, although the playing may be 
more complex if you’re trying to play a full kit’s worth at once.
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Adding more notes to a part
If you have problems playing all of a drum track at once, then there are a num-
ber of ways to do it.  The first way is to record ‘on top’ of the first part you have 
recorded.  Simply go back to the beginning of the track, and then record again on 
the same track – the notes you’ve already played will be played back to you, and 
you’ll create a new part on top of the original one; Cubase will show the part with 
diagonal lines on it to show you that there is more than one part in that location, 
and once you’re happy with the second part you have made, you can select the 
‘glue’ from the toolbar at the top and glue the top part to the bottom – you’ll now 
see a part with both sets of notes in (see diagrams below).  Once you’re finished 
working with the glue, you can return to the arrow tool, either by using the tool-
bar, or right-clicking on the white area of the project window and selecting it from 
the pop-up menu.

Here we see the initial part that has been record-
ed.  Cubase is set to record from the start on the 
same track, and we see below.....

... that the notes get recorded and seem to be in 
the same part, but when your cursor is anywhere 
on that track, the part gets a diagonal pattern on 
it - this shows that there is another part below 
this one.  Both still play, even though they are 
on top of each other.  If we want them to be one 
part, we select the glue from the toolbar above, 
and click on the part, leading to.....

.... a final part which has the notes of both parts.

Picking which tracks play
Cubase has two important buttons which will let you hear the tracks you want, 
and stop others from playing.

Mute
Mute will stop any track that has it turned on from playing.  Click on the button so 
that it is selected in yellow, and play your track back - the track will not be heard.  
You can do this for as many tracks as you want.  To un-mute them, either click the 
mute button on the track, or you can clear all mutes with the clear mutes button 
which is in the toolbar at the top of the window.  

If you want to mute a track you have selected (i.e. it is in white in the list) then 
press M on the keyboard.
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Solo
Solo will mute all tracks other than the one(s) you have soloed (press S).  This 
makes it quick and easy to hear a track you want to hear in isolation.  You can solo 
multiple tracks if you want, and each one is toggled by clicking the solo button 
on the track in question. CTRL clicking a Solo button will mute any other already 
soloed tracks.  As with mute, there is a clear all solo button in the toolbar at the 
top of the window.

Creating an arrangement
Usually, a song will consist of several parts, some of which will be repeated.  This 
can be done quickly and simply in Cubase.  Firstly, create the parts that you want 
to use for the song – you can do this on several tracks, using different instru-
ments, but for clarity the diagrams below will only show one track.
The first thing to realise is that you can move any part to a new location by clicking 
and dragging it there.  When you do so, make sure you have snap turned on, as 
then your part will be in time.  You can also drag a part to a new track to make it 
play on a different sound – sometimes this happens accidentally.  
However, often copies of the original parts are needed, to make the piece larger – 
repeating sections of an entire song, or copying a bar from one place to another.  
There are a few ways to do this, as seen below.

Here we see the original part, 4 bars from bar 1 to 
bar 5.   For each step below, the first part has to be 
selected.
Edit > Functions > Duplicate.  A single copy is 
made, directly after the original part.
Edit > Functions > Repeat.  A new dialogue box 
appears, asking for the number of copies – here 3 was 
entered. Useful for creating many copies.	
Holding down ALT while dragging the part to a new 
location will create a copy – this is useful when a copy 
doesn’t need to be directly after the original.

Using these simple techniques allows a song’s structure to be built up quickly and 
easily.
Practicing a section
When a part is simple to play, then it can often be done with little practice.  But 
sometimes it’s necessary to repeat a section so you can practice or work out what 
you want to play.  Here’s where the locators come in.  Cubase has two main loca-
tors, left and right.  They can be used to create a cycle which Cubase will repeat 
until you tell it otherwise.  To do this, firstly we need to set the left and right loca-
tors.  This can be done in a number of ways:
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1 – Double-click the area on the transport bar where the current value of the 
locator is, and enter a new value.  For bar 5, just hit 5 and Enter on the keyboard.
2 – You can CTRL-click on the ruler (showing the bars across the top of the pro-
ject window’s white area) to set the left locator, and ALT-click to set the right 
locator.  This needs accurate mouse placement, though.
3 – If you have a part or parts that you want to cycle round, select them and then 
hit P on the keyboard.
All of these will set the locators, and once you have done this, you can activate 
Cycle on the transport bar (the button to the left of stop – it will turn blue when 
it’s on), and Cubase will cycle round the contents between the two locators.  You 
can now practice the section that you wish to record or create until you get it 
right.
Cycle Recording
While cycling to play a section and practice it is useful, it is also useful sometimes 
to record while in cycle mode.  This gives a number of different options, including 
recording several different versions of the same part, or to add notes to the part 
as you go.  We will look at three of the available options.
Adding notes to a part
A common need is to add notes to a part.  While we have seen this being used 
when recording without Cycle mode, in cycle mode it is possible too.  The first 
thing is to ensure that the MIDI Record Mode is set to Mix, as seen on the left of 
the transport bar:

If it is not set, click in this area and a pop-up menu will appear, where you can 
select it.

Now, with the locators set, a part can be played.  Each time round the cycle, the 
notes you play will be added to the previous notes - they will not overwrite them.  
This is a quick way of building up a drum part, as seen here.  The first time round 
the cycle, the bass and snare drums were played:
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The next time round the hi-hats were added:

You can cycle round as many times as you like, and whenever you add a note it 
will become part of the recording.
Keeping only the last version
If you want to keep only the last version you record, this is easily done.  Set the 
MIDI Record Mode to Keep Last:

Now proceed as in the previous section; when you stop, only the last version you 
did will be left.  This can be useful when you are trying to get a part right, and will 
stop as soon as you have done that.  Often if you keep starting and stopping to 
record, it can stop you from getting in the feel of things, so having Cubase cycle 
round until you get it correct can save time. 
Recording different versions
Sometimes, you may want to keep recording while you play different versions of 
that section, and then decide later which version you want to keep.  To do this, set 
the MIDI Record Mode to Stacked, from the right-hand side of the pop-up menu 
on the Transport Bar.

As you record with cycle turned on, you will see each part recorded, and it may 
look as if the other versions have been lost (much as in the previous section) - 
here is the result after four cycles.  

Note that the part says Lap 4 - this was on the fourth repeat.  If we play the track 
back, we get the fourth version that was played.  However, the others are still 
present.  
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Clicking the Show Lanes button will reveal the previous 3 Laps.

At present, Lap 4 is the version that is heard.  If you want to hear another one, 
you can use the Comp tool - see page 24 - or you can use the Mute tool to mute 
one of the lanes, and then again to allow another one to play (see page 22 for 
the Mute tool).   The Comp tool is explained on page 445 in the Audio Editing 
chapter, but works for MIDI as well as audio, so the instructions there will show 
you how to use it for more than merely choosing which lane to play.  Note that 
with either method, if you change the lane which is active, the note display on the 
track changes to reflect the part that will be played - here Lap 2 has been chosen, 
and the track part reflects this both in name and note content.

If you want to return the track back to being viewed normally (without lanes), 
then click the Show Lanes button again.
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This represents just a small fraction of the first chapter of the book 
- around 12 pages from a total of over 600.

If you have found this information useful, please consider 
purchasing the book from lulu.com.

Thanks

Darren Jones
(author)


